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SAP2000 v22.2.0 Release Notes 
© 2020 Computers and Structures, Inc. 

Notice Date: 16-October-2020 

This document lists changes made to SAP2000 since v22.1.0, released 06-June-2020. Items marked 
with an asterisk (*) in the first column are more significant. 

Analysis 
Enhancements Implemented 

* Ticket Description 
* 2103 The biaxial friction-pendulum isolator link element now uses tangent stiffness for iteration 

when running nonlinear static, staged-construction, and nonlinear direct-integration time-
history load cases. Previously this isolator used the initial stiffness for iteration in versions 
19.1.0 to 22.1.0. Using the tangent stiffness is generally more efficient, although 
convergence behavior is always problem dependent. This change may cause some 
differences in analysis results from previous versions. These will usually be within the 
convergence tolerance except for numerically sensitive or ill-conditioned models. Results 
for Verification Example 6-011, which can vary with different processors, are slightly 
affected by this change. The tension-compression (T/C) friction-pendulum isolator already 
was using the tangent stiffness for iteration, while the triple friction-pendulum isolator will 
continue to use initial stiffness for iteration. Note that the use of tangent stiffness for the 
biaxial and tension-compression friction-pendulum isolators also makes them suitable for 
pure event-to-event solution methods, but the same is not true for the triple friction-
pendulum isolator using initial stiffness. 

 4900 The initial rigid stiffness of parametric PMM hinges was improved and is now based on the 
stiffness of the frame object containing the hinge. This change is intended to prevent 
excessive stiffnesses which can adversely affect the convergence behavior of the model and 
will not significantly affect analysis results for well-conditioned models. 

* 5134 An enhancement has been made to speed-up the recovery of analysis results, with 
particular improvement for hinge response. In addition, new options are now provided to 
control advanced parameters affecting analysis, design, and response recovery. These 
include: (1) Use of memory-mapped file IO for design and response recovery. This can 
speed-up retrieval of saved analysis results. Systems with Solid State Drives (SSDs) and 
adequate RAM (memory) will benefit the most. (2) Number of analysis threads. Using more 
threads (up to number of physical cores) will speed-up analysis, but also uses more RAM 
(memory) to be efficient. (3) Maximum file size for storing analysis results. This may affect 
certain backup or archival systems. (4) Merging results from non-identical models. Normally 
this is not recommended, but it can be permitted. 

 5137 An enhancement was made to the Nonlinear Parameters form (Define menu > Load Cases) 
to provide a clearer interface. The options "Use Iteration" and "Use Event-to-Event 
Stepping" have been merged into one parameter "Solution Scheme", which specifies the 
overall solution method used in the analysis. The new Solution Scheme options are: (1) 
Iterative Only, equivalent to “Use Event-to-event stepping” = No and “Use Iteration” = Yes 
(2) Iterative Event-to-Event, equivalent to “Use Event-to-event stepping” = Yes and “Use 
Iteration” = Yes (3) Event-to-Event Only, equivalent to “Use Event-to-event stepping” = Yes 
and “Use Iteration” = No. Only the nonlinear parameters relevant to the selected solution 
scheme will be shown in the form. It is suggested to select the solution scheme first before 
specifying the nonlinear parameters, since the nonlinear parameters may be reset when the 
solution scheme is changed. See also Ticket 5187 for additional parameters and changed 
behavior for the Event-to-Event Only solution scheme. 
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API 
Enhancements Implemented 

* Ticket Description 
 2247 An enhancement has been implemented to allow API plugins written in .NET to be added by 

specifying their file location. This removes the previous requirement for .NET plugins to be 
visible to COM and registered. 

Database Tables 
Enhancements Implemented 

* Ticket Description 
* 4919 An enhancement was performed to allow the name of the database file that is 

automatically saved after the analysis is run to include a path. Also, multiple files can now 
be specified to be automatically saved after the analysis is run. 

 
  

* 5140 An enhancement has been made to speed-up repeated solving of the stiffness matrix when 
using the Multi-threaded Solver option. This should significantly increase the speed of 
nonlinear static, nonlinear multi-step static, and nonlinear direct-integration time-history 
load cases, especially when using Newton-Raphson iteration and/or event-to-event 
stepping. Staged-construction load cases will similarly benefit within stages and between 
stages where the structure does not change. Eigen modal load cases will benefit when 
many frequency shifts are performed, and linear direct-integration time-history loads cases 
will benefit when the time-stepping is not constant. This change does not affect the default 
Advanced Solver or the Standard Solver. Use the command Analyze > Advanced SAPFire 
Options to select the Multi-threaded Solver. 

* 5187 An enhancement was made to nonlinear static and nonlinear direct-integration load cases 
that use the "Event-to-Event Only" solution method to better handle how equilibrium 
unbalances are passed to each subsequent step. This change may affect results for non-
iterative event-to-event analyses where the relative unbalance reported in the .LOG files 
are large, but the change is expected to reduce the relative unbalance in the analyses. 
Additionally, four parameters are added to the Nonlinear Parameters form (Define menu > 
Load Cases) to allow more user control for the Event-to-Event Only method: 
(1) Stop Analysis when Maximum Events per Step is Exceeded. Selecting Yes for this option 
enables a new feature where the analysis will terminate if the specified Maximum Events 
per Step is reached in an analysis step. 
(2) Minimum Event Step Size. The minimum event size that is allowed during analysis. When 
the Maximum Null Events per Step is exceeded, events that are smaller than this value are 
increased and counted as Null Steps. 
(3) Maximum Null Events per Step. If this is set to a non-zero value, this is the number of 
events smaller than the specified Minimum Event Step Size allowed in an analysis step. If 
set to zero, the Minimum Event Step Size will not be enforced. 
(4) Use Correction Step for Large Unbalance. The options are "None", "Every Step", and 
"Last Step". When "Every Step" is specified, an additional correction step with no applied 
load will be taken at the end of any step where the relative unbalance is larger than 1.0e-4 
to resolve unbalances in the model before moving to the next step. If "Last Step" is 
specified, this correction step will be taken at the end of a Nonlinear Static load case or at 
the end of every stage for a Staged Construction load case. This parameter is only 
applicable to Nonlinear Static load cases. Event-to-Event Only analysis can be defined by 
setting the "Solution Scheme" option to "Event-to-Event Only" in the Nonlinear Parameters 
form. See also Ticket 5137 for changes to the Nonlinear Parameters form. 
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Design – Cold Formed Frame 
Enhancements Implemented 

* Ticket Description 
* 790 An enhancement has been implemented, adding the cold-formed frame design according to 

AISI 2016.  

Design – Concrete Frame 
Enhancements Implemented 

* Ticket Description 
 4928 An enhancement was added for CSA A23.3-14 concrete frame design code where torsional 

longitudinal rebar required on the tension and compression sides is now designed when 
combined axial force, torsion and shear exceeds the code allowable limit. Torsional 
longitudinal rebar is reported at top and bottom separately when tension and/or 
compression caused by combined axial, shear and torsion are more than the flexural 
longitudinal rebar. 

Design – Steel Frame 
Enhancements Implemented 

* Ticket Description 
 4045 An enhancement has been made in the Russian steel frame design code SP 16.13330.2017 

for buckling calculations of channel sections under the combined action of axial 
compressive force and moment in the plane coinciding with the symmetry plane. Now the 
design no longer checks interaction Eqn. 70 of SP 16.13330.2017 section 8.1.4, which 
corresponds to the case of bending without axial force. Only Eqns. 109 and 111 of SP 
16.13330.2017 section 9.2 need to be checked in the presence of compressive force, and 
this has not been changed. Previous results were overly conservative when also considering 
Eqn. 70. 

 4055 An enhancement has been made in the Russian steel frame design code SP 16.13330.2017 
to distinguish between the two phi_c factors which are reported: (1) phi_c from Table 21, 
and (2) the phi_c factor from clause 7.1.5 to be used in Eq.10. The second one is calculated 
only for channel sections. This is now clarified by specifying the corresponding clauses in 
the header of the table. This was a reporting only issue.  

 4058 An enhancement has been made to the Russian steel frame design code per the Change 2 
of SP 16.13330.2017 (SP 16.13330.2017 7.1.3, Table 7), where for the buckling check of I-
shaped sections, the following buckling curves are now used: (i) The buckling curve "b" is 
used for the major direction buckling for all rolled or welded, doubly-symmetric I-shapes 
except for case (ii). (ii) The buckling curve "a" is used for the major direction buckling of all 
rolled, doubly-symmetric I-shapes with the depth of the section along the web direction 
more than 500 mm. (iii) The buckling curve "c" is used for the major direction buckling for 
all rolled or welded, singly-symmetric I-shapes, and (iv) The buckling curve "c" is used for 
the minor direction buckling for all rolled or welded, singly-symmetric or doubly symmetric 
I-shapes. The buckling curves are used in the determination of axial compression capacity 
per clause SP 16.13330.2017 7.1.3. 

 4064 An enhancement was made to the Russian steel frame design code SP 16.13330.2017 
where now the maximum elastic shear-stresses and the maximum elastic combined-
stresses are checked by comparing them with Rs*GammaC and Ry*GammaC/0.87, 
respectively, at the critical points per the code (SP 16.13330.2017 Eqn. 42, Eqn 44, Section 
8.2.1) for the following sections: Singly-symmetric I-shape, Channel, T-shape, Double Angle, 
and Box sections per the code (SP 16.13330.2017 Eqn. 42, Eqn 44, Section 8.2.1.). 
Previously, those checks were performed only for the following sections: Doubly-symmetric 
I-shape, Double Channels, Rectangular shape, Pipes, and Circles. These checks are not 
performed for any Section Designer, General, or Angle sections. The average shear checks 
based on Q3/Av33 and Q2/Av22 are checked by comparing them with Rs*GammaC for all 
shapes as a simplified measure. These simple checks are still done. The previous results 
were slightly unconservative for the new considered shapes. 
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* Ticket Description 
 4671 An enhancement has been made for the Eurocode 3-2005, Italian NTC 2008, and Italian NTC 

2018 steel frame designs to allow the shear center coordinate, zs, and lateral-torsional 
buckling (LTB) moment capacity, Mcr, for bending about major axis to be overwritten in the 
design overwrites form. In addition, the design buckling resistance moment Mb,Rd for 
section designer and general sections have been updated to include the factor ChiLT due to 
effects of Mcr in the calculation.  

External Import and Export 
Enhancements Implemented 

* Ticket Description 
 4652 The CSI Cloud Explorer has been made compatible with SAP2000 v22. 
 4734 An enhancement was made to import solid primitives from AutoCAD DWG files.  
 5172 An enhancement was made to 

the import of .exr files from Revit. The Revit orientations of framing elements 
with angle, double-angle, tee, and channel sections are now imported. Note that 
this enhancement requires that the .exr files be created in Revit 2021. 

 5359 Two related enhancement were made to the export of area objects to .exr files. (1) Nearly 
vertical area objects, with up to 15 degrees inclination from the vertical plane, are now 
exported to .exr files. Previously they were omitted. (2) Area objects with an inclination 
included between 15 degrees and 45 degrees from the vertical are now exported as slanted 
Revit walls instead of Revit ramps. Note that slanted walls can only be imported into Revit 
2021 and that several Revit related restrictions, documented in the CSiXRevit 2021 Manual, 
apply. 

* 5364 An incident was resolved affecting the import of IFC files that describe structures in 
"structural analysis view". When importing IfcStructuralPointConnection, 
IfcStructuralCurveMember, and IfcStructuralSurfaceMember objects whose 
ObjectPlacement attribute referred to an IfcLocalPlacement that in turn had a 
PlacementRelTo attribute, SAP2000 did not take into account that last attribute. The 
PlacementRelTo attribute indirectly referred to in IfcStructuralPointConnection, 
IfcStructuralCurveMember, and IfcStructuralSurfaceMember objects is now taken into 
account when these objects are imported in SAP2000. Not taking that attribute into 
account typically shifted the entire structure from its location in the originating software, 
but did not affect the analysis results. The import of IFC files that describe structures in 
"architectural coordination view" was not affected. This incident affected all versions of 
SAP2000 capable of importing IFC files that describe structures in "structural analysis view". 
A related enhancement was also made. Objects imported from all IFC files are now 
imported in local coordinates relative to the site coordinate system, instead of in global 
coordinates. The location and rotation of the site coordinate system are stored in the 
SAP2000 model. If the structure is re-exported, the location and rotation of the site are 
included in the export, and the ObjectPlacement attribute of the exported IFC objects is 
exported as a compound transformation that explicitly refers to the location of the site and 
to the relative coordinates visible in the SAP2000 model. 

Installation and Licensing 
Enhancements Implemented 

* Ticket Description 
* 4594 The version number has been changed to v22.2.0 for a new intermediate release. 
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Loading 
Enhancements Implemented 

* Ticket Description 
 5351 An enhancement was made to the Eurocode 8:2004 auto seismic load pattern and response 

spectrum function for the Portugal National Annex where the S factor now incorporates the 
ground acceleration ag when greater than 1.0 m/s^2. 

Results Display and Output 
Enhancements Implemented 

* Ticket Description 
* 920 An enhancement was done to update the Response Spectrum 

Generation form and Response Spectrum Curves form used when creating a response 
spectrum from a joint time history to more clearly display the data. 

Structural Model 
Enhancements Implemented 

* Ticket Description 
* 4718 An enhancement has been made to allow auto-hinges for steel and concrete beams and 

columns to be defined (backbone curve and acceptance criteria) based on rules in ASCE 41-
17. This is an update to hinge definitions based on ASCE 41-13, which option is still 
available. 

User Interface 
Enhancements Implemented 

* Ticket Description 
 4868 The Display Deformed Shape form as been modified so that it fits better on monitors with 

lower resolution.  
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Analysis 
Incidents Resolved 

* Ticket Description 
 4365 An Incident was resolved where a steel or concrete parametric PMM hinge with an "Elastic 

Perfectly Plastic" curve shape and with strength loss enabled would use axial force and 
moment values at points D and E that were different than the values specified in the Force-
Deformation Data form. The axial force and moment values at points D and E used for 
analysis were equal to the force or moment at point U multiplied by the force parameter 
"Ratio Point D/Point B" and the force parameter "Ratio Point U/Point B", which are hidden 
for a "Elastic Perfectly Plastic" but have a default value of 1.5. This issue only affected the 
force and moment values at points D and E for Elastic Perfectly Plastic parametric PMM 
hinges, and it affected all nonlinear load cases. 

* 5124 An issue was resolved where a Nonlinear Static load case with the Load Application Control 
option set to "Displacement Control" could produce results that were dependent on the 
scale factor of the applied load. This occurs if the model had shell objects, the Geometric 
Nonlinearity Parameter was set to "P-Delta", and the Nonlinear Parameters options "Use 
Event-to-event Stepping" and "Use Iteration" were set to "Yes" and "No", respectively. This 
issue only occurred for non-iterative event-to-event analysis and, generally, a larger load 
scale factor would result in smaller equilibrium error at each step. Very small differences 
may now still be exhibited for sensitive models, but they are not of engineering significance. 

 5252 An incident was resolved where the analysis failed to run with a nondescript error message, 
and then caused the user interface to become non-responsive, if the full path to the model 
file contained illegal characters and/or characters from a Windows System Locale different 
than the current setting. Now a proper error message is displayed and the control is 
returned to the user. Corrective action by the user will still be required to run the model, 
either by modifying the model filename and path or the Windows System Locale to be 
consistent with each other. 

API 
Incidents Resolved 

* Ticket Description 
 4637 An incident was resolved for the Application Programming Interface (API) functions 

CableObj.AddByCoord and CableObj.SetLoadTargetForce which did not correctly convert 
the input parameters from the API current units to the model database units. When this 
issue occurred, the changes were consistent with the model shown in the graphical user 
interface. 

 4918 An incident was resolved for the Application Programming Interface (API) where the 
function Results.FrameForce returned an error when used over the entire structure by 
setting the first parameter, "Name", to "ALL" and second parameter, "ItemTypeElm", to 
GroupElm (2). This issue only occurred for models that contained frame elements that were 
internally created from objects that were not frames, such as when edge constraints were 
used. 

 5249 An issue was resolved for the Application Programming Interface (API) where the function 
Results.BaseReactWithCentroid was not able to complete successfully and always returned 
1. Results were not available using this function. No other results were affected. 

Database Tables 
Incidents Resolved 

* Ticket Description 
 3406 An incident was resolved where on import the "Combination Definitions" table did not 

recognize the "None" option for the design items (e.g., field SteelDesign). This issue was 
corrected for version 22.0.0, but inadvertently omitted from the release notes. 
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Design – Cold Formed Frame 
Incidents Resolved 

* Ticket Description 
 4733 An incident has been resolved to correctly select the lightest section within the auto-select 

list for cold-formed design. Previously the lightest section was not always selected. Design 
results may change for existing models run in the new version. 

Design – Concrete Frame 
Incidents Resolved 

* Ticket Description 
 5354 An incident was resolved for AS 3600-2018 concrete frame design where torsional 

longitudinal rebar was reported by combining the top and bottom longitudinal torsional 
rebar instead of reporting the additional torsional longitudinal rebar at the top and bottom 
separately. This was producing overly conservative results. Now, additional torsional 
longitudinal rebar is reported in both the design output and the tabular output for top and 
bottom locations separately. Reported torsional longitudinal rebar is in addition to the 
flexural reinforcement. 

Design – Steel Frame 
Incidents Resolved 

 4360 An incident was resolved where displaying a report when using user-defined table names 
may have caused an exception. 

 4697 An incident was resolved in which the ASCE 7-16 response spectrum database table was not 
exported to Excel. This was a table export issue only and did not affect results. Other export 
formats were not affected. 

 4898 An incident has been resolved to properly export and import the core dimensions of section 
designer sections with rectangular or polygon shape to/from the model text file (.s2k). In 
addition, the program determined core dimensions are also updated immediately after the 
shape is changed using the reshaping tool. 

* Ticket Description 
 1833 An incident was resolved in the steel frame design codes AISC 360-05, AISC 360-10, and 

AISC 360-16 in which the moment capacity in the major principal direction of an angle 
section for the limit state of yielding was being calculated based on the geometric axis 
instead of the principal axis. The design moments are now transformed to the principal axis. 
This issue was resolved for version 22.1.0 but was inadvertently omitted from the Release 
Notes. 

 3022 An incident was resolved to correct the calculation of the lateral-torsional buckling moment 
for singly-symmetric I-sections using the AISC 360-10 ASD steel frame design. Previously, 
the calculated moment was relatively conservative. 

 4036 An incident has been resolved in the Russian steel frame design code SP 16.13330.2017 
where the Phi buckling factor could be calculated incorrectly for the buckling curve "c" 
when lambda_bar was near zero due to the numerical sensitivity of the code equation at 
that limit. Phi should be equal to 1.0 for lambda_bar = 0.0 per the specification SP 
16.13330.2017 Annex E, Table E.1. Now the value of Phi will be set to 1.0 as lambda_bar 
approaches zero. 

 4038 An incident has been resolved in the Russian steel frame design code SP 16.13330.2017 
where now the factor phi_y (phi for minor direction bending, or phi for major direction 
bending only if I22 > I33) is used in the calculation of beta per Table 21 and in the 
calculation of c per Eqns. (113) and (114). Previously the minimum of phi for the major and 
minor directions of bending was being used. This change affects the calculation of factor c, 
which is used in the interaction Eqn. (111) (SP 16.13330.2017 section 9.2.4, Table 21). 
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 4040 An incident has been resolved in the Russian steel frame design code SP 16.13330.2017 
where, for non-rolled I-sections (user-defined/parametric/welded frame section properties 
or for frame members with assigned “Rolled = No” overwrite), the height h is now taken as 
equal to the distance between centerlines of the top and bottom flanges per the code 
specification (SP 16.13330.2017 Eqn. G.5, Annex G). Previously the full height of the section 
was used instead of the distance between centerlines of the top and bottom flanges, and 
the results were slightly unconservative. 

 4042 An incident has been resolved in the Russian steel frame design code SP 16.13330.2017 
where now, when simply-supported beams are checked against shear at the support 
stations, flanges are ignored in Eqn. 42 of SP 16.13330.2017 section 8.2.1, which is used for 
shear strength calculation. According to the code, shear force shall be undertaken by only 
the web at the support stations. Previously flanges were included in the calculation, which 
could be slightly unconservative. 

 4046 An incident has been resolved in the Russian steel frame design code SP 16.13330.2017 
where, for a Channel section when the moment about the axis of symmetry is zero (major 
axis bending, M33=0 in ETABS terms), the power term n used in the interaction equation SP 
16.13330.2017 9.1.1 is now taken as equal to 3 when M22 is zero or positive (the flange tips 
are in tension), and equal to 1 when M22 is negative (the flange tips are in compression) 
based on SP 16.13330.2017 Annex F, Table F.1 case 9. Previously, for a Channel section 
when the moment about the axis of symmetry was zero, n was taken as 1 whether M22 was 
positive, negative, or zero. However, when the major axis bending moment is nonzero or 
nontrivial, the power term n is taken as 1.5, which has not changed. Previously the design 
was slightly conservative. 

 4047 An incident has been resolved in the Russian steel frame design code SP 16.13330.2017 
where now the calculation A_f/A_w for box tube shapes uses the ratio of the flange area 
bounded by the web centerlines to the web area bounded by the flange centerlines. 
Previously, A_f/A_w was calculated using the gross flange area and the clear web area. This 
affects the calculation of c_x and c_y per the code (SP 16.13330.2017 Annex F, Table F.1). 

 4051 An incident has been resolved in the Russian steel frame design code SP 16.13330.2017 
where the calculation Af/Aw for minor axis bending of singly-symmetric I-shaped sections 
now takes the area of the web Aw as the sum of the two unequal flanges (SP 
16.13330.2017 Annex E, Table E.2). Previously, Aw was taken as two times the top flange 
area. The value of Af is taken as the clear area of the web, which is unchanged. The 
calculation of Af/Aw for major axis bending remains unchanged. The Af/Aw ratio affects the 
calculation of eta, which then affects mef and phy_ey per the code (SP 16.13330.2017 
Annex E, Table E.3, 9.2.2). 

 4054 An incident has been resolved in the Russian steel frame design code SP 16.13330.2017 in 
which the buckling factor phi_e for lambda_bar between 0.0 and 0.5 (0.0 < lambda_bar < 
0.5) was previously determined by linear interpolation between the values of phi_e for 
lambda_bar = 0.0 and lambda_bar = 0.5. However, since the phi_e for lambda_bar = 0.0 is 
not given in the code (SP 16.13330.2017 Annex E, Table E.3), phi_e for lambda_bar = 0.0 
was conservatively assumed to be 1.0 for all values of mef. Now, the phi_e for lambda_bar 
between 0.0 and 0.5 is calculated instead by linear extrapolation backward from the values 
of phi_e for lambda_bar = 0.5 and phi_e = 1.0. The previous method was conservative for 
large values of mef. 

 4059 An incident has been resolved in the Russian steel frame design code SP 16.13330.2017 
where now, when the buckling check for box sections subjected to axial compression with 
uniaxial or biaxial flexure is performed, the design checks both Eqn. 120 and Eqn. 121 (SP 
16.13330.2017 section 9.2.10). Previously, this check was performed using only one of 
these equations, depending on the plane in which the moment was applied. The previous 
approach was slightly unconservative. 

 4060 An incident has been resolved in the Russian steel frame design code SP 16.13330.2017 
where the shape influence coefficient (Eta) for T and double-angle sections for bending in 
the plane of the minor axis is now calculated assuming section type 8 per the specification 
SP 16.13330.2017 Annex E, Table E.2. Previously, section type 5 was assumed for this case. 
The Eta factor is used in clause SP 16.13330.2017 9.2.2. 
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Documentation 
Incidents Resolved 

* Ticket Description 
 4716 An incident was resolved where the steel frame design manuals for EC 3-2005 and NTC 

2018 incorrectly documented the equation used for plastic shear resistance accounting for 
torsion for hollow shapes. This was a documentation issue only and did not affect the 
design algorithm or any results. 

Drafting and Editing 
Incidents Resolved 

* Ticket Description 
 4667 An incident was resolved where an unexpected error message was generated when 

attempting to join two or more frame objects using the command Edit > Edit Lines > Join 
Frames. This occurred even when the operation should have been valid.  

 
  

 4061 An incident has been resolved in the Russian steel frame design code SP 16.13330.2017 
where now, when the buckling check for box sections subjected to axial compression with 
uniaxial or biaxial flexure is performed, the design checks both Eqn. 120 and Eqn. 121 (SP 
16.13330.2017 section 9.2.10) with the replacement of phi_x for phi_ex or phi_y for phi_ey 
as appropriate (I_x > I_y and M_y = 0 for Eqn. 120; I_y > I_x and M_x = 0 for Eqn. 121). 
Previously, this check was performed using only one of these equations, depending on the 
plane in which the moment was applied. The previous approach was slightly 
unconservative. 

 4062 An incident has been resolved in the Russian steel frame design code SP 16.13330.2017 
where, for a singly-symmetric I-shaped section when the moment about the major axis is 
zero (major axis bending, M33=0 in SAP2000 terms), the power term n used in the 
interaction equation SP 16.13330.2017 9.1.1 is now taken as equal to 3 based on SP 
16.13330.2017 Annex F, Table F.1 case 6, similarly to doubly-symmetric I-shapes. Previously 
for this case, n was taken as 1.5. Now, for a singly-symmetric I-shaped section: (a) n=2 when 
M33 is significant and M22=0 (case 2) or when neither of them is significant, (b) n=3 when 
M22 is significant and M33=0 (case 6, similar to doubly symmetric I-shapes), and (c) n=1.5 
when both moments are significant (table note*). The only change was for condition (b). 
Conditions (a) and (c) are unchanged. Previously condition (b) was treated as a condition 
(c). 

 4063 An incident has been resolved in the Russian steel frame design code SP 16.13330.2017 for 
singly-symmetric sections, especially for a singly-symmetric I-shaped section and when 
plastic strains are allowed, where now the different values of the section modulus W_y for 
the tips of the top flange and the bottom flange are used in the calculation of interaction 
ratios per Eqn. 105 of SP 16.13330.2017 section 9.1.1. Previously, the design was using the 
minimum of W_y,top and W_y,bottom for both top and bottom corner points. Now the 
design uses Eqn. 105 for all extreme corner points with the appropriate section modulus for 
each point. All singly symmetric sections (singly-symmetric I-shape, Channel, T-shape, and 
Double Angle) are affected. 

 5215 An incident was resolved for the NZS 3404-1997 steel frame design where requesting the 
right-click design details for a solid rectangle (flat plate) section would generate an error. 
This was a results display issue only and did not affect the on-screen and database table 
results. 
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External Import and Export 
Incidents Resolved 

* Ticket Description 
 3038 An incident was resolved which affected the import of DXF files. After importing a DXF file 

defined in AutoCAD units other than the model current units, the model current units were 
changed but the units drop-down list at the bottom right of the user-interface did not 
reflect the change. This was a display problem in the user-interface and did not affect the 
validity of the imported model.  

 5329 An incident was resolved where using the File > Import > Modify STRUDL Section Cut 
command was not prompting for a file, therefore preventing the command from 
functioning. 

Graphics 
Incidents Resolved 

* Ticket Description 
 3394 An incident was resolved where the colors of back face would not display correctly when 

transparency was turned ON and the directional light was off in DirextX graphics mode. 
 4583 An incident was resolved related to legends on contour plots when using DirectX graphics 

mode. For 3D views the numbers were not located correctly and for 2D views the legend 
itself was missing. 

 4607 An incident was resolved where springs applied to solid object surfaces would not display in 
the analysis model view. 

 4644 An incident was resolved where joint symbols would not display correctly when animation 
was turned on in DirectX graphics mode. The joint display size was too small and has been 
corrected. 

Loading 
Incidents Resolved 

* Ticket Description 
* 4506 An incident was resolved where importing a KBC 2009 or a KBC 2016 or a TSC 2018 

Response Spectrum function from a text file (.S2K, $2K), database-table file (Excel, Access, 
XML), or the interactive database editor caused the two specified site coefficients Fa and Fv 
to be ignored and set to 1.0. This generated an incorrect response-spectrum function that 
could significantly affect analysis results when used in a response-spectrum load case. Using 
the menu command Define > Functions > Response Spectrum Functions to modify/show 
the function would restore the affected site coefficients to correct program calculated 
values, and the curve displayed correctly. Clicking OK would then save the correct values for 
analysis, but clicking Cancel would not. The new version will automatically correct the 
response spectrum when the model is rerun. 

* 4939 An incident was resolved where a nonlinear static, staged-construction, or direct-
integration time-history load case that had loads with a scale factor of exactly zero (0) could 
apply additional frame loads that were not specified in the load case. This issue only 
occurred for load cases that continued from the end of another nonlinear static, staged-
construction, or direct-integration time-history load case and that applied frame loads in a 
load pattern, scaled by zero, that was also applied in the previous nonlinear load case (or 
one if its predecessors). When this issue occurred, the load pattern scaled that was scaled 
by zero was being applied with a scale factor from some other load pattern in the same 
load case. The extra loads were reflected in all analysis results, including base reactions and 
frame reactions. This issue affected SAP2000 v21.1.0 to v22.1.0. 
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Results Display and Output 
Incidents Resolved 

* Ticket Description 
 3034 An incident was resolved where the weight modifier specified for the section was not being 

applied when calculating the deformed shape of a frame for display when the cubic curve 
option was on. This was a display issue only and no results were affected. 

 5203 An incident was resolved in which the generated reports were sometimes unable to be 
opened in Word when they contained images. This was a report generation issue only and 
did not affect results. 

 5245 An incident was resolved where elements that are removed during a Direct-Integration 
Time History load case using the "Consider Collapse" option were still displayed in the 
deformed shape after removal in SAP2000/CSiBridge v22.1.0. This was a display issue and 
did not affect the analysis results. 

 5306 An incident was resolved where the signs of forces shown for a Section cut drawn on screen 
was flipped when in DirectX display mode. This did not affect standard-graphics mode. 

Structural Model 
Incidents Resolved 

* Ticket Description 
 3036 An incident was resolved where section cut forces defined by a group and including a shell 

joint where the shell edge has specified releases could be incorrect. This has been 
corrected. This error did not affect section cut forces where the cut line was itself defined. 

* 4808 An incident was resolved for bridge foundation modeling where deleting all the soil layers 
when defining an advanced foundation property would cause the software to terminate 
abnormally next time the same foundation property was viewed for editing. Note that 
when an affected model from a previous version is opened in the new version of the 
software, the affected foundation properties will be lost and will need to be redefined. The 
new version allows foundation properties to be defined that have no soil layers. 

 4902 An incident was resolved where, for a Parametric P-M2-M3 hinge with a Moment-Curvature 
hinge specification type, the tension and compression deformation scale factors were 
shown with displacement units in the Hinge Property Data form, but are actually considered 
as strains for analysis. The Hinge Property Data form has been updated to be consistent 
with analysis. 

 5305 An incident has been resolved for Section Designer in which the rebar material for rebar 
objects (single bar, line, rectangle, circle) could not be changed as intended. Attempts to 
change the rebar material would result in the last available rebar material being selected. 
Results agreed with the actual rebar material shown in the rebar shape definition. 

 5348 An incident was resolved in the New Zealand material property library in which the modulus 
and strength values of the aluminum material were previously defined in the wrong units. 
Existing models using the aluminum material from this library should be reviewed. Results 
agreed with the property values as imported into the model from the library. 

User Interface 
Incidents Resolved 

* Ticket Description 
 2197 An incident was resolved where custom menu shortcut keys for plugins on the Tools menu 

were not being saved. 
 2388 An incident was resolved in which the software would not start from a Windows shortcut if 

the "Run" option in the shortcut properties was changed to "Maximized". 
 3005 An incident was resolved where the drafting reshaper tool would not work correctly for 

area objects. This usually happened when multiple joints of the area were moved in one 
edit. When this happened the error was obvious. 

 3033 An incident was resolved where the joint offsets were not correctly interpolated when 
dividing frames using the frame divide command on the edit menu. 
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* Ticket Description 
 4659 An incident was resolved where two items were corrected in the form for Interpolating 

Damping by Period or Frequency parameters in a time history load case: (1) An abnormal 
condition occurred when deleting a row. (2) When modifying a damping value the new 
value would be lost when the Modify button was clicked. 

 4719 An incident was resolved on the TSC-2018 seismic load pattern form where the SD1 input 
label was shown as SDS. This was only an error with the text on the form and did not affect 
results. 

 5174 An incident was resolved where, for the Pratt truss new-model template, the image 
showing the parametric parameters would not display. This was a user interface issue only. 

 5219 An incident was resolved where changing the load case list order in the load case definition 
form changed the damping values assigned to the cases. 

 5292 An incident was resolved in which an error was generated when creating or editing a load 
case while the model alive feature was enabled. No results were affected. 

 


